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We’re the Macomb Intermediate School District.  We exist to provide our clients quality service, high caliber 
support and cutting edge leadership. 
 
Our primary clients are the 21 school districts of Macomb County.  They are our most important customers--
indeed, our reason for being. 
 
Within these districts we focus our efforts on school staff.  We work to increase their skills and capabilities so their students can 
experience more effective educational programs. 

 
We also serve students with disabilities.  In fact, we are committed to working directly with youngsters with 
disabilities who reside in Macomb County’s school districts. 
 
And we are involved with the educational community across the country.  Many of our staff members are 
deeply involved in state and national programs.  Many are working with colleges and universities.  Still 
others are exchanging information with their professional colleagues.  All these activities have a single 
purpose:  to identify and develop techniques and programs which improve learning opportunities in Macomb 
County. 
 
This is the professional focus which makes the Macomb Intermediate School District one of America’s 
premier regional education agencies. 
 
 

The MISD is an equal opportunity employer.  It is the policy of the MISD that no person on 
the basis of race, creed, color, religion, national origin, age, sex, height, weight, marital 
status, or disability shall be discriminated against, excluded from participation in, denied 
the benefits of, or otherwise be subjected to discrimination in any program or activity for 
which the MISD is responsible. 

 
The MISD will provide, upon request with advance notice, appropriate auxiliary aids and 
services necessary to afford a qualified individual with a disability equal opportunity to 
participate in the services, programs and activities conducted by the MISD.  To request 
auxiliary aids or services, contact Rosetta Mullen, 586/228-3309.  MISD Text Telephone 
(TTY) 586/286-8040. 
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Advantages of Elementary Schools Using Schedules 

 
Elementary schools that use schedules have the following options available to them: 
 
• Ability to print student schedules, class schedules and teacher schedules 
• Ability to produce attendance add-drop reports and other detailed attendance reports 
• Ability to use grade reporting (progress reports/report cards) 
• Ability to use the Walk-In Scheduling atom 
 
Although using schedules requires some additional setup such as creating courses and 
sections, once created, these files can be rolled from year to year. 
 
Below is an example of the SASI Classes atom, which reflects the student’s section and 
course in which she is enrolled in.  
 

 
 
 
For further information on elementary scheduling setup and process, please refer to the 
documentation provided. 
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Course Description 
 
This course teaches you to create teacher, course, and section records. It will also explain 
the scheduling process associated with an Elementary School with schedules.  
 

Expected Outcomes 
Upon Completion of this course you will be able to: 

• Set up the correct fields in the School atom. 

• Add, inactivate and delete teacher records using the Teacher atom. 

• Add, inactivate and delete courses using the Course atom. 

• Add and Duplicate Sections for both Primary and Special Teachers. 

• Create Student Class List atoms to be used to enroll students into Sections (classes). 

• Create Teacher Class List atoms to be used to enroll new or individual students into 
classes. 

 

School Atom 

Elementary, With Schedules  
When this type is selected, SASIxp works with the Sections, Course, and Schedule atoms 
as well as the Teacher atom. For example, the program refers to the Sections atom when 
users find Class Attendance records. It looks for Teacher numbers in the Master Schedule 
(AMST) file when users sort Class Rosters and Attendance reports. 

On the Schedule Tab of the School atom make sure that the School Type is Elementary, With 
Schedules 

 
Some other fields that need to be set up in the School atom are also found on the Schedule Tab 
of the School atom. 
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Gen. Section ID How section IDs are to be generated.  (It is suggested that you choose the 
Course & Manual discussed below.) 
      Course & Manual Tells the program to automatically assign the first portion of each section 

ID, using course numbers. Users can then complete the IDs with additional numbers as 
needed. 
Course Length Maximum number of characters allowed for course IDs. You can allow up to 
14 characters for course IDs.  (3 or 4 suggested here) 
Section ID Length Maximum number of characters allowed for class or section IDs. Specify 
by typing a number from 1 to 18. (6 or 7 suggested here) 

 
 
On the General Tab of the School atom, the Period fields need to be filled in to reflect the number of 
subject areas you need to define in the Course atom. For 11 subjects (courses) the following Periods 
should be filled in. Begin 01, End 11.    
           

 
The Term Duration Tab of the School atom is where the start and ending dates are entered for 
each term.  (This is where the default date is found for starting dates in the Sections atom before 
the school year is started.) For an elementary school with all courses that last all year the 
following setup could be used. Replace the Starting and Ending dates with your schools dates. 
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Using the Teacher Atom 
You use the Teacher atom (Basic Scheduling folder) to set up your teacher records. This is where 
you enter professional information for each teacher and assign the teacher ID’s. After the 
teachers have been entered, this atom can be used to assign a group of students to a specific 
teacher. 

Entering New Teachers 
1. Open the Teacher atom within the Basic Scheduling atom. 

 
2. From the Data Menu, select the ADD option or hold the Control key and press A. The 

Teacher ID field will populate with asterisks. When you complete the steps listed and 
save the next available teacher number in the system will replace the asterisks. 

3. Type in the teachers last, first and middle names in the appropriate fields (Social Security 
number is optional.) 

4. In the Short Name field, type the teacher’s name as you would like it to appear on reports 
where space is limited, and also on the first page of the student form in the Name field 
next to the Tch #. 

5. All of the other fields are optional and can be filled in as you wish. 

6. Click SAVE to record entries, click UNDO to clear entries since the last save. 

To Change Name, SSN, or ID 

1. Open the Teacher atom within the Basic Scheduling atom then find the teacher whose 
record you want to change. 

2. Click on the Teacher menu; select Change Name, SSN, ID option from the drop down 
menu. 
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3. Make the appropriate changes. 

4. Click SAVE to record changes, click UNDO to clear entries since the last save. 

Inactivating Teacher Records 
1. Open the Teacher atom within the Basic Scheduling folder, then find the teacher whose 

record you want to inactivate 

2. Click on the Data menu, then select the INACTIVATE option from the drop down menu. 

3. Click SAVE to make the inactivation effective. Parentheses will appear around the 
teacher’s name in the title bar to indicate an inactive status. Click UNDO to keep the 
teacher active. 

Reactivating Teacher Records 
1. Open the Teacher atom within the Basic Scheduling folder, and then find the teacher 

whose record you want to reactivate. 

2. Click the Data menu, and then select the REACTIVATE option from the drop down 
menu. 

3. Click SAVE to reactivate the records. The Parentheses around the teacher’s name in the 
title bar indicating an inactive status will disappear. Click UNDO to cancel the 
reactivation. 

Deleting Teacher Records 
1. Open the Teacher atom within the Basic Scheduling folder, and then find the teacher 

whose record you want to delete. 

2. Click on the Data menu, and then select the DELETE option from the drop down menu. 

3. At the prompt, “Ok to Delete Records?” click OK. To abandon the delete, click 
CANCEL. 

 

 

 

 

 

 

Deleting is permanent. If a teacher returns to your school, you will need to reenter all their pertinent information. Inactivating 
a teacher keeps their information in you system, but flags the teacher as inactive. If he/she returns to your school, simply 
reactivate their record. 
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Using the Course Atom 
The Course Atom (Basic Scheduling folder) enables you to set up and maintain a record 
for each course taught at your school.  

If you wish to name the courses according to subject matter i.e. ART, ENG, MTH rather 
than have SASIxp assign the next available numeric number you must open the Next ID 
atom (System Setup folder) and change the ACRS file Next Course ID to 0 in the Next 
Number field. Save, Close. 

 
 

Entering New Courses 
1. Open the Course atom within the Basic Scheduling atom. 

 
2. From the Data Menu, select the ADD option or hold the Control key and press A.  

3. In the Course ID field enter the Course ID (chose a combination of 
Alpha/Numeric characters)  if the Next Course ID was set to zero. If not, this field 
will be populated with asterisks and the next ID available will populate this field 
upon saving the information. 

4. In the Course Title field, type in an appropriate Short Title (18 char). This is the 
title that will appear on schedules, report cards and transcripts. 
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5. In the Long Course Title field, type in an appropriate Long Title (40 char). This is 
for descriptive purposes only. 

6. In the Duration field, use the drop down list to select a term duration (YR in most 
cases at the elementary level). 

7. In the Gender field, use the drop down list to select a gender restriction if one 
applies. 

8. In the Low field, use the drop down list to select the lowest grade level allowed to 
take this course. 

9. In the High field, use the drop down list to select the highest-grade level allowed 
to take this course. 

These are the main fields necessary for elementary scheduling. The remainder of the 
fields can be filled in for reference purposes.  If the elementary is using grade reporting, 
including GPA’s and transcripts, the credits and N/H fields impact the GPA.  Refer to the 
Grading Setup handout for further information. 

10. Repeat Steps 2 – 9 to enter all remaining courses. 

NOTE: If SASIxp Grade Reporting and /or InteGrade Pro are being used, all the subject 
areas for which  the student receives a grade will need to be added as a course in SASIxp. 
(i.e. Reading, Spelling, English, Math, Science, Social Studies, Art, Music, PE, Computers, 
etc.) 
Once you have entered all courses, you can open the Course List atom (Basic Scheduling 
folder) to see a list of all courses.  
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Using the Sections Atom 
 
To Create Sections  (For Primary Teachers) 
 
 

1. Open the Sections atom in the Basic Scheduling folder. The atom will open to the Student List page.  

2. From the Data menu, select the ADD option or hold the Control key and press A. Asterisks will appear 
in the Section ID field immediately. These will change when the Course ID has been selected if 
Course & Manual was selected in the School atom.  Otherwise, the next available Section ID will 
replace the asterisks when you finish with the steps below and click SAVE. 

3. Click the blue quick link arrow to the left of the Course field.  The Course List will position itself on the 
far right side of the screen.   Scroll down the list until you find the desired course.  Position your mouse 
arrow on top of the Course ID number, click and hold until an outline box appears.  Drag the outline 
box onto the Sections form and release.  All appropriate Course information will automatically appear.  
(If Course & Manual has been chosen in the School atom, the Section ID field will now be filled with 
the Course ID followed by a hyphen – the actual section ID will need to be entered manually before 
the new section can be saved.) 

4. Enter the second part of the Section ID after the hyphen – Many schools enter the grade level such as 
01, 02 etc..  For those schools with more than one grade level, often the teachers’ last name initial 
followed by grade level is used, such as P1 for Piper grade 1 or J1 for Johnson grade 1.  In the 
example above, D1 would be added for Denise Duffel. 

5. Click the blue quick link arrow to the left of the Teacher field.  The Teacher List will position itself on the 
far right side of the screen.  Scroll down the list until you find the desired teacher.  Drag and drop the 
teacher number onto the Section screen just as you did for the Course.  All appropriate teacher 
information will automatically appear. 

 

6. Fill in the Period (beginning) and Ending from the drop down menu. This should be entered according 
to how you want the courses to show on the class schedule or report cards if using SASIxp grade 
reporting. For example 01 to 01 will print first, 02 to 02 will print second. 
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7. The Lo field should be filled with 01 for grade one and the Hi field with 01 for grade 1. 

8. The Max field should be filled with the maximum number of students allowed in the class.  

9. The room number for the teacher can also be added.  

These are the fields that need to be entered. Any others can be added later if the need arises. 

To Duplicate Sections (For Primary Teachers) 

Keeping the Sections atom open, the Course List atom open, and Teacher List open, you are now 
ready to create sections for all grade levels. It is easiest to enter all sections of one course at a time. 
For example, since Reading RDG was chosen first, all courses of RDG should be added. Be sure to 
add one for each teacher. 

1. From the Section menu, select Duplicate Section.  

The section created on the previous page will now appear as below. 

 

2. From the Teacher List atom (still open on desktop) drag a new teacher onto the Tch# field. The 
new teacher number can also be typed into the Tch# field. 

3. Enter the second part of the Section ID (after the hyphen) with the same identifier as used above.  
In the example shown, since the new teacher’s name is Alicia Adams and she teaches first grade, 
an A1 will follow the hyphen:  RDG-A1. 

4. The Lo and Hi fields should be modified accordingly. When the second grade teacher is added to a 
section, the Lo and Hi fields should be filled with 02. 

5. The room number for the teacher should also be changed.  

6. Repeat Steps 2 – 5  (Duplicate Sections Primary Teachers) until all sections of Reading have been 
created. 

Continue creating the next course by following the steps outlined in the  “Create Sections for Primary Teachers”  
area on page 10-11.   
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To Create Sections (For Special Teachers) 

Repeat all steps for creating sections for primary teachers, except when entering the manual part of the Section 
ID, enter the same ID used for the Primary Teacher.  For example, the Section ID for Art would Be ART-D1 for 
Denise Duffel and ART-A1 for Alicia Adams. 

To Duplicate Sections (For Special Teachers) 

With the appropriate Section open (in this case ART), Select Duplicate Sections from the Sections menu. 

The following window will appear. 

 
The only field that needs to be changed is the manual part of the Section ID.  There 
should be a section of Art created for each primary teacher in the school.   

To View / Edit Sections 
1. Open the Sections atom.  In Find mode, type an asterisk in the Section ID field. Click 

FIND. 

A Matrix of all sections like the one below will appear. 
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If something is missing or wrong in this list, double click on the Section ID to view or modify a 
particular section.  

To Find sections for a certain teacher:  In Find mode, enter the teacher number in the Tch# field 
and click FIND. A matrix like the one above will appear, including only sections assigned to the 
specific teacher. A different matrix will appear with the selection of different parameters. 

To Create Lists of Students to Enter into Teacher Sections 
Once all sections have been created, the easiest way to create Student Schedules is to add the 
students to the sections that they will be a part of. 

1. Open the Student or Enrollment atom. 

2. Perform a Find using criteria designed to produce a matrix that includes the students you 
want to enroll in certain sections. For example a matrix of all the 1st grade students. 

 
 

3. Holding down the Shift key, click each student ID in the Student (Enrollment) matrix that 
you are going to add to certain sections. Release the Shift key and drag and drop all of the 
highlighted students onto a blank area of the desktop. A new atom will be created for this 
list of students. 



  

15

 
To rename the Mike (list) atom, close all forms on your desktop. Highlight the Mike (list) atom 
and from the File menu choose Atom Info. 

The following window will appear. 

 
Repeat Steps listed above to create Lists for all students.  

To create a “Student Class Lists” Folder in which to store all of your lists, go to the File menu 
and select New Folder.  In the Save As field, type: “Student Class Lists” and click SAVE.   Once 
the folder is created, you can drag and drop the student lists onto the new folder. 

 

 

Change the Name Mike (list) to the 
class list of the teacher whose 
students have been selected. I.e. 
Duffels D11st grd stu list 
 
 
A Description may be added if 
wished. 
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To Enroll Students into Classes 
1. Open the Section atom. 

2. Perform a find to produce a matrix listing all sections for an individual teacher.  

This can be done in one of two ways. If you only wish to list the Primary teachers sections 
(classes) enter the primary teacher’s number in the Tch# field and click FIND. The following 
matrix will appear. 

 
If you wish to list the Primary teacher’s sections (classes) along with special teacher’s sections 
(classes) enter    :D1 in the Section ID field.  The wildcard “:” is used to find entries which 
contain certain characters and D1 is the manual part of the Section ID that represents Denise 
Duffel’s sections (classes). 

 
Click FIND 

The following matrix will appear. 
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3. Regardless of which Matrix you choose to use, double click on the first Section ID. This 
will open the Section where the students will be enrolled.  

 
4. Drag the correct student class list atom onto the section, in this case drag Duffels List 1st 

Grade atom onto the section “Student List” page. 

5. The students in the atom will be added to the Sections atom.  

The students are added to the matrix in the Sections atom in alphabetical order. 

The system date defaults in the Start Date cell for that student. If this process is done before the 
start date on the term duration page of the School atom the date will default to the date selected 
there. If the school year has already started you can mass change this start date later. (HINT: You 
can temporarily change the system date to the first day of school if you are adding numerous 
students.) 

The students will be enrolled into the section as shown below. 
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6. Close this section. 

7. Repeat steps 3 – 6 until the students have been enrolled in all the sections for this teacher. 

Once all students have been enrolled for this teacher, you are ready to repeat the above process 
for the remaining primary teachers and special teachers in your school. 

To View a student’s schedule 
1. Open the Classes atom (Student Info folder, or Basic Schedule folder) 

2. Find the student whose schedule you wish to view. 

 
3. From the Classes menu select CLS32 to print class schedules. 

4. Class Rosters can be printed for individual sections from the Student atom. Open the 
Student atom select Class Rosters W/Sched (STU41) and choose to print individual 
sections or all sections for a certain teacher. 

To Create Lists of Sections (Classes) for Scheduling New Students 
Before scheduling an individual student, the following steps should be followed. Teacher Class 
List atoms should be created in a similar fashion to creating Student List atoms.  

1. Open the Section atom. 

2. Perform a find to produce a matrix listing all sections for an individual teacher. If you 
want to include the special classes in a student’s schedule, you can enter the “contains” 
wildcard colon preceding the manual part of the Section ID that represents the teacher’s 
sections (classes).  For example, to create a list of all sections taught by Denise Duffel, 
enter  :D1 in the section ID field when performing a find.  
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The following matrix will appear: 

 
3. Holding down the Shift key, click on the “Section ID” title. This will select or highlight 

all the sections (classes) in Denise Duffel’s section list. Release the Shift key, place the 
mouse over any of the beginning period fields, click and hold to see a shadow box, and 
then drag and drop all of the sections onto a blank area of the desktop. A new atom will 
be created (named for the first section selected from the Section matrix). In this case, the 
atom is titled ART-D1 (list) 1.  Close all forms on your desktop and follow directions 
previously outlined to rename the atom. 

Repeat Steps listed above to create all teacher class lists. Then create a new folder to keep all the 
class lists in.  

NOTE: After creating new atoms, from File in the menu bar select Save Desktop.   

 

To Assign a Schedule to a New (Individual) Student 
1. Open the Classes atom (Student Info folder, or Basic Scheduling folder). 

2. Find the Student for whom you wish to schedule classes. 

3. Select the correct Teacher Class List atom from those you have created and drag this 
atom onto the Classes atom. The student will then be scheduled into all the sections 
(classes) that are assigned to this teacher. 
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4. Click Save if this schedule is correct. 

5. The start date will automatically default to the system date. If this student is scheduled 
before school begins, the start date will be determined by the start date on the Term 
Duration Tab of the School atom. If you need to change the start date for the individual 
student, click on the Classes menu, select Show Start Dates. A new column will appear 
and the dates can then be manually changed. 
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Elementary Scheduling ~ In Practice 
 
 
 

Warren Consolidated Schools 
 

Building Level documentation 
 

By: Janet Cameron 
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Elementary Scheduling 
 
 
1. Create ToolBar for Elementary Scheduling 
 

Utilities Folder 
 Query Atom 
 Generic Selection 
Basic Scheduling Folder 
 Sections 
 Teacher List 
 Course List 
 Classes 

 
2. Click on Query Atom 

 
Create the following filter changing the grade to the appropriate 
grade. 
 
KEEP ASTU if GR = 00 and Status = ‘ ‘ 

 
3. Click on Sections Atom 

Find section number for first Kindergarten class 
 
4. Open Generic Selection and arrange windows on screen  
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5. Double click on the names on the left side of the screen that you 
wish in this section.    

Once you have all the names on the right for this section, click on 
the Blue heading that says Selections (25) on the right side of 
the screen.  This will highlight all the names. 

 Click and hold the mouse button until you get the marching ants and 
  Then drag the names over to the Section in the upper right  
  Corner of the screen and drop it on the sections. 
 
6. Repeat this process for all sections in that grade level. 
 
7. When grade level is complete, remove filter from System Filter 

Folder. 
 
8. Repeat steps 2 – 7 for each grade level. 
 
9. When completely finished make sure all filters are removed from the 

System Filter Folder. 
 
10. In Sections, click on Sections on the Menu bar at the top.  Click on  

Update Counts. 
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ELEMENTARY SCHEDULING FOR REPORT CARDS: 
        (4th & 5th Grade Pilot only) 
 
Complete the first ten steps above for all grades. 
 
Open Mass Assign Classes Atom in the Basic Scheduling Folder. 
 

 
  

On the left side, Search List, click on the Section Lookup Arrow at the 
top and select the section for Teacher A for the 4th Grade Section. 
In this example from Lean,  Teacher A is teacher #102, Carpenter. 
 
On the right side, Add List, click on the Section Lookup Arrow at the 
top and select all the sections for 4A except Band.  Those will have to 
be individually scheduled. 
 
Fill in the start date of 08/26/03. 
 
Click ASSIGN. 
 
Repeat this process for 4th Grade Teacher B and Teacher C 
Repeat this process for  all 5th Grade Teachers. 
 

In Sections, click on Sections on the Menu bar at the top.  Click on  
Update Counts. 
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Elementary Scheduling ~ In Practice 
 
 
 

Utica Community Schools 
 

Building Level documentation 
 

By: Kathy Werner



  

26

 
Elementary Procedure for Assigning Students to Classes 

 
 
1. Log into the new school year (2006) 
 
2. Open the Sections Atom  

   Select Sections dropdown menu from the grey bar across the top  
     Select MST02 report  
          

 
 
    3. Change the report to the MST03 report 

Print the MST03  
   Make all corrections to the teachers/sections/rooms etc. on the report. 
      Make the same corrections in the sections atom. 
         If a teacher changes, make additions/deletions in the teacher atom. 
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4. Open the Sections Atom 
   Find the section/class you are ready to assign students to 
      Drag the open section to the bottom right of your screen 
 

 
 
5. Open the student atom 

   Select FIND  
        Place an * in the last name field  
           Select the grade level you’re working on from the dropdown grade field 
   Select FIND  (all students in that grade level will appear in a matrix) 
                           Hold the Shift key down and select the students that are assigned to the 

first section/class that you have open. Drag the highlighted names 
to the open section. (The student names will now be listed in that 
section/class) 
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6. If you need to take a student out of a section/class, select the student, go up to the   
      sections dropdown and select Drop Student.  A box will appear, select Delete    
      permanently (No History Record) SAVE 
 
7.  Repeat for each section/class and grade level. 
 
8. Stay in the sections atom, select Sections from the dropdown and choose Update 

Counts. (must be on a section when updating counts)  
 

9. Print new MST03 to verify master schedule. 
 

10. When finished, run the following two queries to place the teacher number on the 
student screen in the Tch/Advisor and Counselor fields.  
    These queries will also fill in the teacher number field on the enrollment atom. 
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